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Quick & Easy Quotation

BIM objects are designed for use with the Autodesk REVIT software.

A how-to guide is included with all of our BIM downloads. Additionally if further 
support is required our staff are always on hand to help.

BIM downloads allow you to produce an automatic bill of quantities, ensuring an 
easier and quicker quote turnaround.

Atkore Marco is now able to offer its uPVC trunking and Steel Wire Cable Tray products as 
downloadable BIM object files.

Both the uPVC and Steel Wire Cable Tray are available in a single download, with all products 
included, finding and installing products into a REVIT model much easier.

BIM is an ever-growing initiative, backed by the UK government, to establish new standards within 
the UK’s construction industries. The BIM process is intended to involve all parties during the 
design and management phases of a project, by enabling contractors and designers to list all 
objects required for the build in a digital model. 

As manufacturers, Atkore Unistrut & Marco are always looking for ways to meet its customers’ 
demands, and new initiatives will see BIM being used more and more as the UK Government 
moves to make it the standard practice for all their new builds.

All BIM files are available from the Atkore Marco website!

Work-flow and Commands

Instant Enquiries

After the add-in has been installed, the REVIT ribbon bar will contain a Marco tab where Atkore Marco products can be 
selected.

Export objects direct to a predefined template, which open directly into Excel.

Building Information Modeling

BIM

Industry-leading products,
Industry-leading customer service.

Atkore Marco is committed to providing an unparalleled customer service, with dedicated account 
managers, always on hand to answer any queries or questions. 

Atkore Unistrut & Marco’s sales team is fully trained in all products and are able to offer guidance and 
advice to aid any query.
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 Duct Sizes
 Duct System Types
 Duct Types
 Project Parameters
 View Templates

Select : OK 

This will bring all the required routing preferences, etc into your project to allow you to work with the Trunking Layout 
tools. 

Import the Marco Schedule into your project. 

Select: Insert > Insert from File > Insert Views from File 

Browse to C:\Marco\Marco Trunking.rvt 

Select: Open 

Choose Marco Enquiry (Trunking) from the available views, and select: OK 

You are now ready to create your Cable Trunking Layout. 

Draft User Guide / Workflow 

All Marco Cable Trunking Families and Routing has been created using 
standard Revit Duct / Duct Fittings and Accessories.  

Provided with the Add-in: 

A Revit Project containing Routing preferences for All Marco Cable Trunking 
Ranges, this will allow users to transfer the “duct types” using the Transfer 
Project Standards. 

A Marco Ribbon Bar to select the appropriate commands for laying out 
Trunking, converting the layout to Actual Parts and exporting information to 
the Marco Enquiry Form. 

Set Up: 

Open the supplied Marco Trunking Revit file from C:\Marco\Marco 
Trunking.rvt 

Open the project you wish to use the Marco Cable Trunking in. 

From within your project select: Manage > Transfer Project Standards 

Choose Marco Trunking.rvt from the drop down list. 

Select: Check None 

Add Check Marks to:  

Atkore Marco Cable Trunking
Add-in for Autodesk Revit
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Part of the requirements for the Marco Add-In is for all rooms within your project to have a Revit space added. 

This allows the automation, correct placement and orientation of trunking components. 

The outline workflow is as follows: 

1. Add Spaces to your linked Building model.
2. Select the correct Trunking Range from the Routing selection tools including options.
3. Draw your Layout Trunking. Note: this can only be done inside a space!
4. Add accessories or additional components such as End Covers.
5. Export Schedule for Enquiry.
6. Add Real Fittings for Higher Detail Model and information.
7. Use the Marco View Template to Hide Underlying Layout Items.

Note: Real Fittings will be removed if the underlying layout items change in any way and will need to be replaced. 
This is not an automated procedure. 

Workflow and Commands: 

After the Add-In has been installed, the Revit ribbon bar will contain a Marco Tab with the following Commands: 

Marco Trunking Tool Bar Commands. Fig1 

Layout Trunking: 
 The Workflow for placing Trunking is very similar to using the standard ducting tools within Revit and will look similar to 
the standard Rectangular Ducts. 

To facilitate the correct selection, width and height settings you must use the Route Selection tools not the standard 
Revit Type Selector as underlying components will not be placed. 

Route Selection Tools. Fig 2 

Installation Guide
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The Marco Trunking Tool will display the following dialog box: 

The left column displays the available trunking ranges. 

When you select a range the image to the right displays the 
trunking profile. 

Only valid options specific to that range will be available to 
select prior to placement. In the Example shown, Self-
Adhesive, Divider & TOA (Take Off Adaptor) cannot be 
selected or values added for their quantity. 

Once your selection and options have been selected and you 
select OK, you will be passed to the normal Revit duct drawing 
tool. The correct duct routing preference along with the 
correct width and height chosen for that trunking type will be 
set. This takes in to account the view type you are in too. If you 
are in a Plan view or 3D view the width is set to the smaller 
dimension of the Trunking, whereas if you are in an elevation or 
section it will be the opposite way around allowing you to draw 
on the wall in the correct orientation. 

 The Marco Trunking Tool Dialogue Box. Fig 3 

If you know that there are no options to be added to the trunking layout you can use the Quick Select pull down from the left 
button as indicated in Fig 2 

Enquiry Level of Detail drawing: 

The Marco add-in will add all additional items based on your selection criteria. For this reason there is no real need to split long 
trunking lengths into 3m sections as the trunking length and joint cover quantity are managed in the background and can be 
created when converting Layout Trunking to Real Fittings later. However if you wish you can spit the trunking manually using 
the standard Revit split tool and a joint cover will be placed at the split position. 

When you draw your Trunking, Set your Offset Level, this is to the trunking centreline. (Do not use ductwork justification to set 
it to Left/Right or Top/Bottom). 

Ductwork in Revit does not get associated to the wall within a Revit project. Draw your trunking away from the wall but inside 
the room. Once drawn use the align tool to place the back of the trunk on the wall face. As this is done the internal and 
external corners are corrected to suit their new location. 

You can draw Trunking vertically in a plan view as normal by setting the new offset value and using the apply button. 
Alternatively you can create an interior elevation or section perpendicular to the wall you are placing the vertical Trunking. 
Drawing Trunking in this view will automatically work out if the Flat Angle Elbow is an Up or Down version. 

Installation Guide

5



Trunking Branches:  Angle, Tee & Take Off Adaptors

Revit Internally when drawing a Junction will make the size of the branch Trunking / Ducting / Pipework the same size as 
the Item you are drawing from. When you have selected the start point of your branch Trunking you will need to set the 
size of the trunk you want to draw to match the required Trunking type.  

WORKFLOW: 

1. Set your view to be the Elevation or section looking at the wall you’re drawing your branch on.

2. Select the Trunking Type for the branch you wish to draw from the Marco Trunking command.
(Note: If you are adding a Mini Trunking to an ELITE 3 or ELITE 3 Compact you MUST select TOA (Take Off Adaptor)
as an option when selecting MM1, 2 , 3 or 4 in the Marco Trunking Dialogue, see below Fig 4

Take Off Adaptor Selection: Fig 4 

3. Select your start point on the Centreline of the trunk you want draw away from.
(Note: If you are wanting to draw branch trunking which has a different size to the main trunking as in adding a Mini
Trunking run to an Elite 3 or Elite 3 Compact you will need to set the values for the size of the branch trunking prior to
selecting its second point). see table below.

Sizes for Trunking with Reducing Branches: 

Branch Size: Width: 170, Height: 50 
Branch Size: Width: 16, Height: 16 
Branch Size: Width: 25, Height: 16 
Branch Size: Width: 38, Height: 16 

APOLLO 4 to APOLLO 3: 
ELITE 3 & ELITE 3 Compact to Mini1:  
ELITE 3 & ELITE 3 Compact to Mini2:  
ELITE 3 & ELITE 3 Compact to Mini3:  
ELITE 3 & ELITE 3 Compact to Mini4:  Branch Size: Width: 38, Height: 25 

4. Pick the second point for the end of your branch trunking.

Installation Guide
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TRUNKING MODIFICATION: 

NOTE: Because the length of trunking will change and fittings will be configured due to their placement position, if any 
element of a trunking run is modified, its associated Real Elements will be removed and will have to be replaced using the 
Marco Create Real Fittings. 

Change Options Trunking Network: 

Using this option allows you to change the underlying options of either the connected underlying Trunking Network or a 
Selection of trunking items. 

Use the Change Option: Trunking Network if all items on the entire linked Trunking belong to the same Trunking type. 

Change Options Tools. Fig5 

Select the command from the ribbon bar. Select an item of trunking and it 
will select all linked items. If there are different trunking types you will 
receive a warning: 

If this is the case select only items of the same type, then use the Change 
Options: Selection method. 

If All Items are of the same Trunking Type you will be presented with the Change 
options Dialogue Box. 

Select the items to you wish to update the Trunking with. 

Select OK 

NOTE: This will remove all items placed originally and add the new selected items. 

As this is a modification, it will also remove ALL placed Real Trunking Lengths, 
these items will need to be re-created with the Marco Create Real Fittings 
command. 

Change Options Dialogue Box. Fig  7 

Change Options Warning.  Fig 6 

Installation Guide
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Create Real Fittings: 

This Option is created to add Real Graphical Elements to the Trunking Layout  for Construction Documents / 
Photorealistic Presentations. All Quantification is maintained when these items are added. 

Select the Items you wish to have Real Components created. Select the Marco create Real Fittings command. 

This will run through each Item selected and change or add trunking 
items. On placement of trunking lengths you will be presented with 
the following dialogue box. 

Your view will also zoom to the trunking length which is being 
modified. It will allow you to change the handing of the trunk 
being placed. i.e. if you are using a non symmetrical Trunking 
type such as an Elite 60, APOLLO Skirting this will allow you to 
choose the correct orientation on placement (Position of the 
Top compartment). You can select Don’t show this again, this 
will use the same setting for the placement of parts for this 
occasion. 

If you miss or incorrectly select the wrong handing for an item, you can change this later in the properties pallet by selecting 
the trunking length and changing its “Handing” property. 

Marco Enquiry: Export to Excel 

Selecting the Export to Excel option will transfer the Schedule: Marco Enquiry (Trunking) to an Excel Spreadsheet using the 
predefined Marco template. It will be called the same name as your Revit Project and placed in the same location as the 
Revit Project File. 

When the Enquiry Form is created you will be asked if you want to open the file. 

If an Enquiry file exists you can open that file without having to browse to it by using the Open Marco Enquiry command. 

Marco Create Real  Fittings.  Fig 8 

Trunking Handing Option.  Fig 9 

Marco Create Real  Fittings.  Fig 10 

Installation Guide
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Model Display and Documentation: 

The Make Real tool adds Revit families which are superimposed over the Layout Ductwork used originally to position your 
Trunking. When working with the Marco Trunking tools it will be necessary to switch back and forth between Real and 
Layout modes. 

This can be done in two ways. Temporarily or Permanently by applying the View Templates provided in the Marco 
Trunking.rvt file. And shoud have been transferred when you started your project. 

Temporarily: 
On the Revit View Control Bar select “temporary view properties” 

Then select either, Marco Layout Trunking or Marco Real Trunking From the Menu. 

Temporary View Properties Menu  Fig 11 

If the one you require isn’t in your list,  

Select “Temporarily Apply Template Properties”  

This will take you to the full list of view templates.  

Set your view type filter list to <All> you will see the Marco View Templates, 

Select the one you require and Select OK 

This will set the view and the option will be available in the First Menu (Fig 12) 

 View Template Menu  Fig 12 

Permanently: 
To permanently apply the view template to your view you can do this by going to: 

View > View Templates > Apply Template Properties to Current View and follow the same procedure as in Fig 12 

Installation Guide
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Revit View Control Bar.  Fig 11 
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